
Sending an e-mail message by using mail merge involves six major steps: 

 

There is a tutorial of using MSWORD for Mail Merge at this site: You might read over it before using the 
steps later as found in MSWord Help. 
  

Note: there is sometimes a problem when using an Excel file as the source for the 
addresses when the address includes a leading zero in the zip code.  In Excel, to 
display the leading zero of a zip code click Format...click Cells...click 
Special...click Zip Code.  You should be able to view the leading zero in Excel 
now and the leading zero should also print in your mail merge. 
 
Click here: Microsoft Word Mail Merge  

1. First, you set up the e-mail main document. The e-mail main document is the model on 

which each individual message is based.  

2. Then, you connect the e-mail main document that you just set up to a data file that 

contains the e-mail addresses of the recipients. More about data files later.  

3. Next, you write the e-mail message. This involves adding two kinds of information to the 

e-mail main document:  

 Information that is the same in every e-mail message. Usually, if you send a 

message to a group, most of the message is the same no matter who receives it. For 

example, in the message to customers, the sale information is the same in each message.  

 Placeholders (officially called fields) for information that is unique to a specific 

message. For example, in the message to customers, you might want to greet each customer 

by name and include a personal note about the customer's preferred coffee roast. To make 

that happen, you add placeholders for the name and the personal note to the e-mail main 

document.  

4. Then, you preview the messages to make sure that information from the data file merged 

correctly.  

5. Next, you send a test message. When the test message is sent and you're completely 

happy with the results, you complete the merge.  

6. Finally, you send the entire set of messages.  

Step 1: Set up the e-mail main document 

The e-mail main document is the model message on which each individual message will be 

based. To set up this main document, you just click a few appropriate options in the Mail Merge 

task pane. Here's how to do it: 

1. Start Word.  

2. On the Tools menu, point to Letters and Mailings, and then click Mail Merge to open 

the Mail Merge task pane.  

3. In the task pane, under Select document type, click E-mail messages. Under Step 1 of 6 

at the bottom of the task pane, click Next: Starting document.  

4. Do one of the following:  
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 If you're creating the e-mail message from scratch, click Use the current 

document. When you started Word, a blank document opened by default. That open default 

document is a perfectly good place for you to compose your e-mail message.  

 If you already have a document that contains the text that you want to include in 

the e-mail message, click Start from existing document. Under Start from existing, click 

Open. Locate the document, and then click Open.  

5. Under Step 2 of 6 at the bottom of the task pane, click Next: Select recipients.  

Step 2: Connect to the data file 

When you use mail merge to send e-mail messages, Word requires the e-mail addresses for the 

message recipients. You provide that information by connecting the e-mail main document to a 

data file that includes, at the very least, a category (column) that lists each recipient's e-mail 

address. 

This data file can come from lots of different places. For example, you might: 

 Have your recipient data, including e-mail addresses, stored in a Microsoft Access 2002 

or Microsoft Office Access 2003 database, a Microsoft Excel 2002 or Microsoft Office Excel 

2003 worksheet, or a table in Word.  

 Keep your current recipient data in your Outlook Contacts list.  

 Want to use the recipients listed in your Outlook or Outlook Express Address Book.  

 Want to create a new data file that contains the e-mail addresses that you want to use. 

You can create a new data file in Word.  

To learn about the different types of data files that Word can connect to and for additional 

information about data files and how to use them in a mail merge, click a link in the See Also 

section of this article. 

Tip  Include yourself in the data file as a recipient. Then, when it's time to send the merged 

messages, you can first send a test message to yourself to make sure that the message content 

looks exactly the way you want and that the messages are actually being sent. 

If you want to use your Outlook Express Address Book as the data file 

To use your Outlook Express Address Book as a mail-merge data file, you have to export the 

address book as a text file.  

1. Start Outlook Express.  

2. On the File menu, point to Export, and then click Address Book.  

3. In the Address Book Export Tool dialog box, click Text File (Comma Separated 

Values), and then click Export.  

Don't be afraid of this weird-sounding file type. It just means a text file where commas 

separate the columns from one another. It has a .csv extension, and you can open it in Excel. 

4. In the Save exported file as box, type a file name for your exported contacts file, and 

then click Browse.  
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5. In the Save As dialog box, in the Save in box, choose where you want to save the file, 

and then click Save.  

Time-saving tip   It's handy to save your data files in the My Data Sources folder in your 

My Documents folder. That's where Word searches first for data files when you browse for 

them during a merge. 

6. Click Next. Select the check boxes next to the categories of information that you want to 

export, and then click Finish.  

Consider this   When you're deciding which categories of information to export, think about 

the e-mail message that you're creating. For example, if you're sending e-mail messages to 

customers and you want to include customers' names in the messages, you'll need to export at 

least the name and e-mail address categories. You won't need to export nickname, personal 

Web site, or other categories of information that you don't need in the message. 

7. When you see the message that the export procedure is completed, click OK.  

8. Close the Address Book Export Tool dialog box by clicking Close, and then exit 

Outlook Express.  

In the step where you connect to a data file, click Use an existing list, and browse to locate the 

.csv file that you just exported. If Word asks you to choose what separator character will separate 

one column from another in your address list, click Comma. Then click OK. 

If you want to send merged e-mail messages to recipients in your Outlook Global Address Book 

To send merged e-mail messages to recipients in your Outlook Global Address Book, you have 

to export those recipients to an Outlook Contacts folder. Here's how to do that:  

1. Open Outlook.  

2. On the Tools menu, click Address Book.  

3. In the Address Book dialog box, on the Tools menu, click Options.  

4. Under Keep personal addresses in, select the Contacts folder that you want to export the 

recipients to, and then click OK.  

Note  If this is a different Contacts folder from the one that you typically use, be sure to 

change this setting back after you finish adding entries. 

5. In the Type Name or Select from List box, type the name of the recipient whom you 

want to import into your Contacts folder.  

6. In the list below, right-click the name, and then click Add to Contacts.  

7. The Contact form for the recipient opens. Update any information that you want to 

change, and then click Save and Close.  

Note  You might have to click the Close button to close the Contact form. 

8. Click the Close button to close the Address Book dialog box.  
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If you open the Contacts folder, you can see the recipient whom you just added. 

If you intend to include personalized information, such as a name or a personal note, in 

individual messages 

For each personalized item that you want to include in the merged e-mail messages, you must 

have a corresponding category (column) in your data file. 

For example, if you want to address each customer by name and include a personal note, your 

data file must contain columns for name and personal note. The data file might look like this. 

 
 

In the section about writing the e-mail message and adding placeholders, we'll talk about how to 

indicate where you want each piece of information to appear in the message. 

If you want to filter the data file by type of recipient or another category 

If you want to send e-mail messages to subsets of the recipients in your data file, make sure that 

you can filter on each subset. 

For example, if you want to send e-mail messages only to customers who prefer a specific coffee 

roast, your data file must contain a category (column) for preferred roast. Or, if you want to send 

the original message to customers and a slightly revised version to coffee company managers, 

your data file must contain a category (column) for recipient type. 

You'll learn more later about how to filter a data file during the mail-merge process. 

To establish a connection between your e-mail main document and your data file 

In the Mail Merge task pane, under Select recipients, you have three options: 

 Use an existing list  Click this option if you already have a data file, such as an Excel 

worksheet, an Access database table, or a Word table, that contains your recipients' names and 

addresses.  

Note  Remember, if you want to use your Outlook Express Address Book as a source for the 

message recipients, you can't connect to that address book directly. You must export the 

address book to a text file first and then use this option to connect to the text file. 
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 Select from Outlook Contacts  Click this option if you want to use names and addresses 

from your Outlook Contacts list.  

 Type a new list  Click this option if you don't have a data file that contains recipients' 

names and addresses.  

Click one of the following options to find out what to do next. 

Use an existing list 

1. Under Use an existing list, click Browse to locate your mailing list data file.  

2. In the Select Data Source dialog box, locate the file, select it, and then click Open.  

3. If you see the Select Table dialog box, click the table or worksheet that contains your 

recipient names and addresses.  

4. The Mail Merge Recipients dialog box opens.  

Select from Outlook Contacts 

1. Under Select from Outlook contacts, click Choose Contacts Folder.  

If you see the Choose Profile dialog box, choose the profile that includes the Contacts list 

that you want to use, and then click OK. 

2. In the Select Contact List Folder dialog box, click the Contacts folder that contains your 

recipient names and addresses, and then click OK.  

3. The Mail Merge Recipients dialog box opens.  

Note  If you run into problems connecting to your Contacts folder, you can get problem-solving 

help by clicking an Answer Box link in the See Also section of this article. 

Type a new list 

1. Under Type a new list, click Create.  

The New Address List dialog box opens. Under Enter Address information, you see a list 

of categories, such as First Name, Last Name, and Address Line 1. You need to modify 

this list so that it matches the categories of information that you want to record about your 

recipients. For example, although the list in the dialog box includes items such as Title, 

Home Phone, and mailing address information, you might want your list to include only First 

Name, Last Name, E-mail Address, and Personal Note. 

2. To edit the list of categories, click Customize.  

3. In the Customize Address List dialog box, use the buttons to add, delete, or change the 

order of the categories. When the list looks the way that you want, click OK.  

4. Type the information for the first entry in the New Address List dialog box.  

5. Click New Entry, type the information for the second entry, and so on.  

6. After you type entries for all the recipients, click Close.  

7. In the Save Address List dialog box, type a name for the file, and then click Save.  
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8. The Mail Merge Recipients dialog box opens.  

By default, if you don't change the location, the data file that you just created is saved to the My 

Data Sources folder in your My Documents folder. This is a convenient location. If, in the future, 

you want to send a new set of e-mail messages by using the same data file, Word automatically 

searches first for the file in the My Data Sources folder. 

Tip  If you want to add to or change the data file that you just created, you have a couple of 

options. You can open the file in Access and modify it there. Or you can make changes to the file 

in Word during a mail-merge process:  

 Go through the steps in the Mail Merge task pane until you come to Select recipients.  

 Click Use an existing list, and then click Browse.  

 Open the mailing list data file that you created. In the Mail Merge Recipients dialog 

box, click Edit.  

 The Customize Address List dialog box opens, and you can change categories, add new 

entries, and more.  

Filtering and sorting 

The Mail Merge Recipients dialog box gives you the opportunity to filter or sort the entries in 

the data file. For example, your data file might include all of your customers, but you might want 

to send the sale announcement only to those whose preferred roasts match the roasts that are on 

sale. Or your data file might include both customers, who are the intended recipients, and 

managers of the coffee franchise to whom you want to send copies. 

If you want to send messages to all the recipients in your data file and you don't need to do any 

sorting or filtering, just click OK to move on. 

If you don't want to send messages to all the recipients in your data file, you can do some or all 

of the following things before you click OK: 

 To eliminate one recipient, click the check box at the beginning of the recipient's row to 

clear it.  

 To sort the rows according to the ascending or descending order of information in a 

particular column, click the column heading. For example, if you wanted to sort your customer 

list by preferred roast so that all of the Sumatra lovers are grouped together, you can click the 

preferred roast column heading.  

 To filter the list according to specific criteria (for example, customers' preferred roasts), 

click the arrow next to a column heading. When you click the arrow, you see a list that looks 

similar to this.  

 
 



Click (All) if you previously filtered the list and now want to include all the entries again. 

Click the value by which you want to filter the list. In this example, the values are coffee roasts. 

By clicking one roast, such as Sumatra, you can restrict the list of recipients to those customers 

whose preferred roast is Sumatra.  

Click (Blanks) to filter the list to only those entries in this column that are blank.  

Click (Nonblanks) to filter the list to only those entries in this column that have content.  

Click (Advanced) to open the Filter and Sort dialog box, where you can narrow the list 

according to more complex criteria. For example, you can narrow the list to two or more 

different values.  

Note  Any filtering and sorting changes that you make in the Mail Merge Recipients dialog box 

don't affect the original data file. 

After you close the Mail Merge Recipients dialog box, you're ready to move to the next step. 

Under Step 3 of 6 at the bottom of the task pane, click Next: Write your e-mail message. 

Step 3: Write the e-mail message and add placeholders 

Now you add content to the e-mail main document. This content includes: 

 Information that is the same in each message   For example, in the case of the e-mail 

message to customers, the description of the sale is the same in every message. You can just 

type or paste this information right into the e-mail main document.  

Note  This is where, instead of adding an attachment to your message, you can add the contents 

of a document to the body of the e-mail main document. On the Insert menu, click File. Locate 

and select the document with the content that you want to include, and then click Insert. The 

dialog box closes and the document's content appears in the e-mail main document. 

 Information that is unique to each message, such as the recipient's name   You can't 

type information that is unique to each message into one e-mail main document. Instead, you 

add placeholders, or fields, to the main document. These fields correspond to categories 

(columns) in your data file. When you complete the mail merge in the next step, information 

from each row in the data file replaces the fields to create a set of unique e-mail messages.  

Here's how an e-mail main document might look with fields in it. You can identify the fields 

because they are always surrounded by chevrons (« »). 



 
 

Now take a few seconds to look at the Mail Merge task pane. Notice the list of links under 

Write your e-mail message (such as Address block, Greeting line, or More items). As the 

following procedure shows, you click these links to add fields to your e-mail main document. 

To add placeholder fields 

1. Make sure that the insertion point is in the e-mail main document at the position where 

you want to add a field, such as a name or personal note field. In the Mail Merge task pane, 

click More items.  

2. In the Insert Merge Field dialog box, click Database Fields. Under Fields, you can see 

a list of the categories (columns) from your data file.  

3. Click the field that you want to insert (for example, Name or Personal Note), and then 

click Insert.  

A field surrounded by chevrons (« ») appears in your document. 

Note  If you don't see all the fields that you want to insert, you may be trying to insert custom 

fields that you added to a view in an Outlook Contacts folder. For information about how to 

do this, click an Answer Box link in the See Also section of this article. 

4. Click Close.  

5. Repeat steps 1 through 4 until you have added all the fields that you want to add.  

Now, you're ready to preview your personalized messages. 

Step 4: Preview the merged messages 

When you click Next: Preview your e-mail messages at the bottom of the Mail Merge task 

pane, information from the data file replaces the placeholder fields in the messages. You can 

click the double-arrow buttons in the task pane to page through the messages, or you can click 

Find a recipient to locate a specific message. 



 
 

Some things that might need fixing 

 Unintended recipients  If messages were created for recipients whom you don't want to 

include in this mailing, click Edit recipient list in the Mail Merge task pane to open the Mail 

Merge Recipients dialog box, and then filter the list of recipients. Or, just clear the check box 

to the left of each name that you want to omit.  

 Missing recipients  If only a subset of the records (rows) in your data file was merged 

into the messages, click Edit recipient list in the Mail Merge task pane to open the Mail 

Merge Recipients dialog box. Make sure that you haven't inadvertently filtered the list of 

recipients. Click the arrow in the column heading for each category that you don't want to filter, 

and then click (All) in the list.  

If you haven't filtered the list of recipients in any way, check your data file to be sure that it is 

organized correctly. 

Step 5: Prepare and send a test message and complete the merge 

As I mentioned earlier, it's a good idea to send one test message before you send the entire set of 

messages. A test message gives you the opportunity to to see if the messages will actually be sent 

and to verify that the message says exactly what you want. If you didn't add yourself to the data 

file, you can still send a test message if you can recruit a volunteer from among the recipients. 

Prepare to send a test message 

Use the double-arrow buttons in the task pane to display the message to yourself or to the person 

who has volunteered to receive the test message. By displaying this message on the screen, you'll 

be able to choose it quickly in the next step.  

Send the test message 
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When you're satisfied with the way your messages look and the appropriate message is displayed 

on the screen, click Next: Complete the merge at the bottom of the Mail Merge task pane. 

Then, do this: 

1. In the Mail Merge task pane, under Merge, click Electronic Mail.  

2. In the Merge to E-mail dialog box, make sure the To box contains the name of the 

column from your data file that lists e-mail addresses. If it doesn't, click the arrow and then 

click the column name.  

3. In the Subject line box, type the subject that you want to send with the messages.  

4. In the Mail format box, click HTML.  

5. Under Send records, click Current record, and then click OK.  

The test message should appear in your Inbox or the Inbox of the volunteer recipient. 
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